

Введение
Инструктаж по технике безопасности в школе

1.Общие требования

1. В учебном кабинете должна быть медицинская аптечка с набором необходимых медикаментов и перевязочных средств для оказания первой помощи при травмах.

2. Учитель обязан соблюдать правила пожарной безопасности, знать места расположения первичных средств пожаротушения и направления эвакуации при пожаре.

3. В процессе работы учитель обязан соблюдать правила личной гигиены, содержать в чистоте рабочее место.

4. При несчастном случае учитель обязан немедленно сообщить об этом директору, зам. директора по УВР.

5. При заведовании учебным кабинетом необходимо выполнять требования и строго соблюдать инструкцию по охране труда заведующего учебным кабинетом образовательного учреждения.

6. Учитель, допустивший невыполнение или нарушение инструкции по охране труда учителя школы, привлекается к дисциплинарной ответственности в соответствии с правилами внутреннего трудового распорядка и, при необходимости, подвергается внеочередной проверке знаний норм и правил охраны труда.

2.Требования охраны труда перед началом работы учителя
1. Включить полностью освещение в кабинете, убедиться в исправной работе светильников. Наименьшая освещенность в кабинете должна быть не менее 300 лк (20 Вт/м2) при люминесцентных лампах и не менее 150 лк (48 Вт/м2) при лампах накаливания.

2. Убедиться в исправности электрооборудования кабинета:

· светильники должны быть надежно подвешены к потолку и иметь cветорассеивающую арматуру;

· коммутационные коробки должны быть закрыты крышками - корпуса и крышки выключателей и розеток не должны иметь трещин и сколов, а также оголенных контактов.

3. Убедиться в правильной расстановке мебели в кабинете:

· расстояние между наружной стеной кабинета и первым столом должно быть не менее 0,5-0,7 м;

· расстояние между внутренней стеной кабинета и столами должно быть не менее 0,5-0,7 м;

· расстояние между задней стеной кабинета и столами должно быть 0.7 м;

· расстояние от классной доски до первых столов должно быть 2,4-2,7 м;

· расстояние от классной доски до последних столов должно быть не более 8,6 м;

· удаление мест занятий от окон не должно превышать 6,0 м.

4. Проверить санитарное состояние кабинета, убедиться в целостности стекол в окнах и провести сквозное проветривание кабинета.
5. Убедиться в том, что температура воздуха в кабинете находится в пределах 18-20°С.

Требования по охране труда во время работы учителя.
1. Посадку учащихся производить за рабочие столы, соответствующие их росту:

2. Учащимся со значительным снижением слуха рабочие места отводятся за первыми и вторыми столами. Учащимся с пониженной остротой зрения места отводятся ближе к окну за первыми столами. Учащимся с ревматическими заболеваниями, склонными к частым ангинам и острым воспалениям верхних дыхательных путей, рабочие места отводятся дальше от окон. Не менее двух раз в год учащихся, сидящих в крайних первом и третьем рядах, меняют местами с целью предупреждения нарушения осанки и искривления позвоночника.
3. С целью обеспечения надлежащей естественной освещенности в кабинете не расставлять на подоконниках цветы.
4. Все используемые в кабинете демонстрационные электрические приборы должны быть исправны и иметь заземление или зануление.

5. Стекла окон в кабинете должны очищаться от пыли и грязи, а также должна производиться очистка светильников не реже двух раз в год. Привлекать учащихся к этим работам, а также к оклейке окон запрещается.
6. При открывании окон рамы фиксировать в открытом положении крючками. При открывании фрамуг обязательно должны быть ограничители.

7. Во избежание падения из окна, а также ранения стеклом, не вставать на подоконник.
8. Во время проведения занятий в кабинете любому учителю школы необходимо разъяснять ученикам правила поведения учащегося на уроке и контролировать соблюдение дисциплины.

4. Требования охраны труда для учителя в аварийных ситуациях
1. При возникновении пожара немедленно эвакуировать детей из здания, сообщить о пожаре администрации учреждения и в ближайшую пожарную часть по телефону 101, начать эвакуацию воспитанников на эвакуационную площадку, приступить к тушению очага возгорания с помощью первичных средств пожаротушения.
2. При получении травмы немедленно оказать первую помощь пострадавшему, сообщить об этом администрации учреждения, при необходимости отправить пострадавшего в ближайшее лечебное учреждение.

5. Требования охраны труда по окончании работы преподавателя
1. Выключить все демонстрационные и электронагревательные приборы.
2. Убрать документацию, методические пособия, демонстрационный материал, привести в порядок рабочее место.
3. Проветрить помещение, закрыть окна, фрамуги и выключить свет.

Раздел 1. Ознакомление с предприятием

1.1. Характеристика предприятия (название, форма собственности, производственная деятельность)

Муниципальное казенное общеобразовательное учреждение "Средняя общеобразовательная школа №18" (МКОУ "СОШ №18") городского округа Нальчик Кабардино-Балкарской Республики (ИНН 0711043570, КПП 072601001, ОКПО 23329671, ОГРН 1050700214388.

Учредитель: Местная администрация городского округа Нальчик Кабардино-Балкарской Республики

Срок действия лицензии: бессрочно

Кем выдана: Министерством образования и науки КБР

Направления образовательной деятельности: 

дошкольное образование, начальное общее образование, основное общее

образование, среднее (полное) общее образование, дополнительное образование.

Адрес фактического местонахождения: 
360024, РФ, КБР, г.о.Нальчик, ул. Неделина, 9

 1.2.Структура предприятия (службы и подразделения)

Управление школой осуществляется в соответствии с Законом Российской Федерации «Об образовании» и Типовым положением об общеобразовательном учреждении в Российской Федерации на принципах демократии, гуманизма, общедоступности, приоритета общечеловеческих ценностей, жизни и здоровья человека, гражданственности, свободного развития личности, автономности и светского характера образования.

Управление школой осуществляется на основе сочетания принципов самоуправления коллектива и единоначалия.

В основу положена пятиуровневая структура управления.

Первый уровень структуры – уровень директора (по содержанию – это уровень стратегического управления). Директор школы определяет совместно с Советом школы стратегию развития школы, представляет её интересы в государственных и общественных инстанциях. Директор школы несет персональную юридическую ответственность за организацию жизнедеятельности школы, создает благоприятные условия для развития школы.

На втором уровне структуры (по содержанию – это тоже уровень стратегического управления) функционируют традиционные субъекты управления: Совет школы, педагогический совет, родительский комитет, профсоюзный орган.

Третий уровень структуры управления (по содержанию – это уровень тактического управления) – уровень заместителей директора. Этот уровень представлен также методическим советом. Методический совет – коллегиальный совещательный орган, в состав которого входят руководители школьных МО.

Четвертый уровень организационной структуры управления – уровень учителей, функциональных служб (по содержанию – это уровень оперативного управления), структурных подразделений школы. Методические объединения – структурные подразделения методической службы школы, объединяют учителей одной образовательной области.

Пятый уровень организационной структуры – уровень учащихся. По содержанию – это тоже уровень оперативного управления, но из-за особой специфичности субъектов, этот уровень скорее можно назвать уровнем «соуправления». Иерархические связи по отношению к субъектам пятого уровня предполагают курирование, помощь, педагогическое руководство.

В школе созданы органы ученического самоуправления, ученические организации. Органы ученического самоуправления действуют на основании утвержденных Положений.

Органы школьного самоуправления, их функции и полномочия:

Формами самоуправления школы являются:

· Совет школы

· Общее собрание трудового коллектива

· Педагогический совет

· Родительский комитет

· Совет школы

Деятельность Совета школы регламентируется Уставом и Положением о Совете школы.

Совет школы:

· определяет стратегию развития школы;

· утверждает основные направления развития школы;

· разрабатывает меры по совершенствованию содержания образования, внедрению инновационных технологий;

· ведает вопросами этики и гласности;

· контролирует расходование средств, являющихся собственностью школы;

· утверждает отдельные локальные акты, регулирующие деятельность школы;

· заслушивает отчеты директора о работе школы;

· создает временные или постоянные комиссии, советы по различным направлениям работы школы, устанавливает их полномочия;

· участвует в разработке и согласовывает локальные акты школы, устанавливающие виды, размеры, условия и порядок произведения выплат стимулирующего характера работникам школы, показатели и критерии оценки качества и результативности труда работников школы;

· осуществляет другие функции, предусмотренные Положением о Совете школы.

Заседания Совета школы созываются по мере необходимости, но не реже одного раза в полугодие.

Решения Совета школы принимаются открытым голосованием. Решения Совета школы являются правомочными, если на его заседании присутствовало не менее двух третей состава и за них проголосовало не менее двух третей присутствующих. Решения Совета школы, принятые в пределах его полномочий, являются обязательными для администрации и всех членов трудового коллектива школы

Педагогический совет школы

Организация учебно-воспитательного процесса осуществляется Педагогическим советом, в состав которого входят все педагогические работники школы. Педагогический совет действует на основании Положения о Педагогическом совете, утвержденного Советом школы.

Педагогический совет школы:

· рассматривает основные вопросы учебно-воспитательного процесса в школе;

· разрабатывает меры по совершенствованию содержания образования, внедрению инновационных технологий;

· принимает решение о переводе и выпуске обучающихся;

· обсуждает и утверждает планы работы школы;

· заслушивает информацию и отчеты педагогических работников школы и представителей организаций и учреждений, взаимодействующих со школой, по вопросам образования и воспитания обучающихся; о проверке соблюдения санитарно-гигиенического режима школы; об охране здоровья и труда обучающихся и другие вопросы образовательной деятельности школы;

· принимает решения об исключении обучающихся из школы в установленном законом порядке;

· осуществляет другие функции, предусмотренные Положением о Педагогическом совете.

Педагогический совет созывается по мере необходимости, но не реже четырех раз в год.

Для ведения протокола и организации делопроизводства из числа педагогов избирается секретарь Педагогического совета. Председателем Педагогического совета является директор школы. Решения Педагогического совета являются правомочными, если на его заседании присутствовало не менее двух третей состава, принимаются открытым голосованием, большинством голосов и являются обязательными для всех участников образовательного процесса. Решения Педагогического совета оформляются приказом директора школы. Организацию выполнения решений Педагогического совета осуществляет директор школы.

Родительский комитет школы

В целях привлечения родительской общественности к активному участию в жизни школы, укрепления связей между школой и семьей, реализации прав родителей на участие в управлении школой создается Родительский комитет школы, который действует на основании Положения о Родительском комитете, утвержденного Советом школы.

Родительский комитет школы:

· вносит на рассмотрение органов самоуправления школы предло-жения по организации и проведению внеклассной работы с обучающимися, по организационно- хозяйственным вопросам, по улучшению работы педагогического коллектива с родителями;

· устанавливает связи с административными органами, обществен-ными организациями, предприятиями, учреждениями по вопросам оказания школе помощи в проведении воспитательной работы, укреплению ее материально-технической базы;

· принимает меры общественного воздействия по отношению к родителям обучающихся, не выполняющим законодательство об образовании, нарушающим права обучающихся;

· участвует в работе по профориентации обучающихся путем организации экскурсий на производство, встреч с людьми разных профессий;

· участвует в работе по контролю за организацией питания обучающихся.

Структура методической работы

Педагогический коллектив школы работает над проблемой «Личностно-ориентированный подход к обучению и воспитанию обучающихся с использованием современных образовательных технологий».

Для реализации основных задач в школе созданы предметные методические объединения, действующие на основании соответствующих положений.

Каждый учитель состоит в методическом объединении.

В школе работают три методических объединения:

· учителей-предметников

· учителей начальных классов

· классных руководителей

Учителя школы принимают активное участие в разработке олимпиадных заданий, в работе районных МО, выступают с докладами.

Творческие группы учителей традиционно совместно готовят материалы для участия в конкурсах различного уровня.

По всем учебным предметам реализуется базовый уровень обучения учащихся. Все учителя имеют необходимую методическую литературу по своему предмету (стандарты, календарно-тематические планы, поурочные планы, разработки уроков в нетрадиционной форме, разработки внеклассных мероприятий по предмету и т.д.). Все учащиеся обеспечены учебниками и необходимыми учебными пособиями. Учащиеся из неблагополучных семей получают бесплатные учебники в школьной библиотеке. Фонд школьной библиотеки позволяет организовать учебно-воспитательный процесс на хорошем уровне.

Раздел 2. Компьютерный дизайн и 3D моделирование
2.1. Создание изображений с использованием графического редактора MS Paint
Графический редактор Paint ориентирован на процесс “рисования” изображения и комбинирования готовых фрагментов, а не на обработку (“доводку”) готовых изображений, таких как отсканированные фотографии.

В вашем распоряжении различные средства и инструменты для “художественного” творчества – палитра цветов, кисть, аэрозольный баллончик, ластики для стирания, “карандаши” для рисования геометрических фигур (линий, прямоугольников, эллипсов, многоугольников). Редактор позволяет вводить тексты, и богатый набор шрифтов из комплекта Windows дают возможность выполнять на картинках эффектные надписи. Имеются и “ножницы” для вырезания фрагментов картинки, - вырезанный элемент можно переместить, скопировать, уменьшить, увеличить, развернуть и т.д.

Основные возможности Paint

1. Проведение прямых и кривых линий различной толщины и цвета.

2. Использование кистей различной формы, ширины и цвета.

3. Построение различных фигур - прямоугольников, многоугольников, овалов, эллипсов - закрашенных и не закрашенных.

4. Помещение текста на рисунок.

5. Использование преобразований - поворотов, отражений, растяжений и наклона.

Создание рисунка.

Для создания нового рисунка применяют пункты меню “Файл” и “Создать”. После этого в рабочей области окна появится белый прямоугольник, на фоне которого и работают. Если рисунок, который ранее находился в рабочей области, не был сохранен, то перед его уничтожением ПК задаст вопрос: “Сохранять изменения в файле ...?” с вариантами ответа “Да”, “Нет” и “Отмена”. Выбор варианта “Отмена” приведет к отмене команды создания рисунка.

Примечание. Для изменения стандартного размера рисунка следует указать курсором правый нижний угол белого прямоугольника. При этом курсор поменяет свой вид на две стрелки. Далее следует перенести курсор при нажатой левой кнопке мышки на новое место.

Для того чтобы рисовать, закрашивать, менять цвет, делать надписи, стирать и т.д. в Paint необходимо выбрать нужный инструмент. Для этого используется палитра инструментов. Необходимо щелкнуть на кнопке с нужным инструментом. После этого выбранная кнопка будет находиться в нажатом состоянии. Курсор мыши также изменит свою форму. Перемещение курсора по рабочей области при нажатой левой кнопке мыши приводит к использованию инструмента и изменению рисунка. При отжатой кнопке мыши происходит простое перемещение курсора без изменения рисунка.

 Панель инструментов Paint

1. Карандаш - при нажатой левой кнопки мыши за курсором мыши рисуется его след выбранного цвета толщиной 1 пиксел. При отпущенной левой кнопке след не рисуется.

2. Кисть - действие похоже на карандаш, но можно менять форму кисти - кружок, квадратик, линия и др.

3. Распылитель - рисование с эффектом распыления краски.

4. Ластик - для стирания части рисунка. Можно менять размер ластика. Удаленный участок будет закрашен цветом фона.

5. Заливка - позволит закрасить выбранным цветом внутреннюю часть произвольной замкнутой области. Для этого требуется выполнить щелчок в любой точке внутри области. Если область не является замкнутой, то закрасится вся рабочая область.

6. Линия - предназначена для рисования прямой линии (отрезка) выбранного цвета и толщины. Концы отрезка - места, где была нажата и отпущена левая кнопка мыши.

7. Кривая - предназначена для рисования гладких кривых линий, соединяющих заданные точки, выбранного цвета и толщины. Сначала проводят прямую линию, затем при нажатой левой кнопке мыши кривую можно дважды изогнуть в указанных направлениях.

8. Прямоугольник - используется для рисования закрашенных и незакрашенныхпрямоугольников и квадратов. Требуется нажать на левую кнопку мыши, перенести курсор в иную точку и отпустить кнопку. Возможные режимы - “только рамка”, “рамка и заполнение”, “только заполнение”.

9. Многоугольник - рисование многоугольников. Для рисования первой стороны требуется перетащить курсор при нажатой кнопке. Для построения следующих сторон можно щелкать мышкой в вершинах многоугольника.

10. Эллипс - рисование эллипса, вписанного в намеченный прямоугольник. Можно выбрать режим (см. прямоугольник).

11. Округленный прямоугольник - рисование прямоугольника с округленными вершинами.

Для сохранения рисунка в файле используется подменю “Файл”. В нем есть две команды - “Сохранить” и “Сохранить как”. Команда “Сохранить” сохраняет рисунок в файле с ранее заданным названием. Команда “Сохранить как” сохраняет рисунок в файле под новым названием. Если сохраняют только что созданный рисунок в первый раз, то компьютер для обеих команд попросит указать название.

Если рисунок не был сохранен после последнего изменения, то при попытке 1) открытия готового файла, 2) создания нового файла, 3) завершения работы с Paint, компьютер спросит о необходимости сохранения изменений.

Внешний вид диалогового окна “Сохранения файла”.

Для задания нового названия файла на экране появится диалоговое окно “Сохранение файла”. Название папки для сохранения указывается в раскрывающем списке в левом верхнем углу правее надписи “Сохранить в”. Если требуется сменить диск, то необходимо нажать на кнопку с треугольником и выбрать нужный диск. Список всех папок и файлов текущей папки (диска) выведен в прокручиваемом списке в центре диалогового окна. В этом списке можно выбрать нужную папку и файл для сохранения. В нижней части окна находятся поля ввода названия файла и его типа (см. таблица.1). Также там находятся две кнопки “Сохранить” и “Отмена”. В Панели инструментов диалогового окна есть кнопки - “Переход в папку верхнего уровня”, “Создать новую папку”, “Список” и “Таблица”.

2.2. Монтаж изображений.  Создание различных эффектов в PHOTOSHOP
Основное назначение редактора Photoshop состоит в ретуши готовых изображений (доведении их до полиграфического качества), в монтаже композиций из отдельных фрагментов, взятых из различных изображений, и в применении специальных эффектов, называемых фильтрами.

Основными техническими операциями при работе с изображениями являются:

-изменение динамического диапазона (управление яркостью и контрастностью изображения);

-повышение четкости изображения;

-цветовая коррекция (изменение яркости и контрастности в каналах красной, зеленой и синей составляющих цвета);

-отмывка (изменение яркости отдельных фрагментов);

-растушевка (сглаживание перехода между границами отдельных фрагментов);

-обтравка («вырезание» отдельных фрагментов из общей композиции);

-набивка (восстановление утраченных элементов изображения путем копирования фрагментов с сохранившихся участков);

-монтаж (компоновка изображения из фрагментов, скопированных из других изображений или импортированных из других редакторов).

Любое изображение может быть изменено до неузнаваемости, если воспользоваться возможностями Adobe Photoshop. Эта программа позволяет создавать невероятные эффекты, стирая грани между реальностью и иллюзией.

При помощи фильтра Nick Collection (Color Efecs Pro 4) можно научиться менять стиль, контраст, яркость изображения, а также делать всевозможные креативные эффекты.

Чтобы добавить желаемый эффект, пользователь обязан открыть в программе изображение, которое нуждается в корректировке. Далее на панели инструментов следует выбрать пункт «Фильтр», после чего перейти в «Галерею фильтров». В ней предложено достаточное количество интересных вариантов. Пользователь должен просмотреть их, теоретически «примеряя» к изображению.

Существует несколько фильтров, которые сопровождаются достаточным количеством дополнительных эффектов. К таким популярным фильтрам относятся имитация, искажение, текстура, штрихи, эскиз и прочие.

Применив определённый фильтр, не следует от него сразу же отказываться, если с первого взгляда результат не впечатляет. Совсем не мешает поработать над глубиной теней, размером изображения, текстурой. Каждое действие, произведённое над изображением, способно в корне его преобразить.

3D-эффект в Фотошопе

Для того чтобы создать такое оригинальное изображение, первоначально нужно запастись основой. Пользователь должен выбрать объект, который полностью обездвижен. Этот объект необходимо дважды сфотографировать, но с небольшим смещением, в пределах двух сантиметров.

После того как основа для создания 3D-фото подготовлена, пользователь может приступать к практическим действиям. Первоначально следует обе полученные фотографии загрузить и расположить рядом, условно называя первый снимок левым, а второй — правым.

Правый снимок следует скопировать, после чего открыть левый снимок и вставить скопированный правый снимок. Получится два слоя, в которых важно не запутаться, слоем 1 считается правый снимок, а Background — левый.

Кликнув двойным щелчком по первому слою, следует вызвать Layer Style Box, после этого перейти в Advanced Blending, затем сразу же обнаружить и перейти в Channels. Там уже установлена в маленьком окошке галочка, которую следует снять. Это позволит устранить с правого изображения все красные оттенки, в результате чего на фото начнут проявляться стереоэффекты.

Следующий шаг предусматривает открытие Background, переименование его в слой 0, а далее выбор Move Tool. Приблизительно в центре фото следует выбрать условную точку фокусировки, относительно которой следует немного сдвинуть правую фотографию. Лишние края 3D-изображения обрезаются. Отредактированное 3D-фото сохраняется, после этого надеваются 3D-очки и визуально оценивается результат работы.

Проделав единожды такие корректировочные действия, впоследствии делать 3D-изображения будет совершенно несложно.

Создание VHS эффекта

Разобраться и в этом вопросе несложно, если скрупулёзно изучить рекомендации опытных пользователей. Первоначально следует написать что-либо, выбрав шрифт, подходящий к стилю ретро. Далее этот текст необходимо продублировать трижды.

Далее, чтобы добавить VHS, необходимо поработать над каждым из трёх созданных дублей. Открыв первый дубль, вызывают меню «Уровни», в котором устанавливают нулевой показатель на красном и зелёном канале, соответственно, изображение станет синим.

2.3. Использование примитива в качестве заготовки для  создания сложной формы
Наряду с разнообразными линиями и кривыми, векторные редакторы имеют в своем составе специальные инструментальные средства для создания простых форм (графических примитивов), что упрощает построение сложных объектов. Среди примитивов находятся такие фигуры как Rectangle (Прямоугольник), Ellipse (Эллипс), Polygon (Многоугольник), Spiral (Спираль). Часто наряду со своим прямым назначением простые формы используются в качестве исходных заготовок для создания на их базе более сложных объектов. В этом случае для последующего редактирования созданных заготовок необходимо привлечение технологии редактирования кривых Безье с помощью перемещения узлов и управляющих точек.
2.4. Coral Draw. Изменение основной формы объектов. Абрисы
По умолчанию палитра цветов располагается на экране CorelDRAW справа от области иллюстрации. Щелчок на стрелке “вниз” внизу и стрелке “вверх” наверху строки палитры позволяет прокручивать её, открывая новые цвета. Щелчок по стрелке влево открывает весь набор цветов (в четыре столбца). Свернуть палитру цветов обратно в один столбец можно щелчком в нижней части около края палитры.

Заливка – заполнение цветом, узором или текстурой внутренней области, охваченной контуром закрытого объекта. Чтобы применить цвет из палитры цветов для заполнения выбранного объекта, нужно лишь щелкнуть на квадратике данного цвета.

Абрис – окантовка, которая формирует контур некоторого объекта (может быть и просто линией). Цвета абрисов выбираются таким же способом, как и цвета заполнения, за исключением того, что при этом для выбора цвета используется правая кнопка мыши.

CorelDRAW обеспечивает широкое многообразие стилей абрисов. Для их создания существует несколько способов. Абрисы можно определять с помощью элементов управления свитка, всплывающей панели или панели свойств.

Самый быстрый способ назначить ширину абриса выбранного объекта (или объектов) — щелкнуть на инструменте Outline (Абрис) в наборе инструментов и выбрать нужную ширину из всплывающей панели. Здесь доступны несколько стандартно установленных линий абрисов разной ширины в пунктах (1/72 дюйма). Можно выбрать волосяную линию (1/4 пункта), абрис 1/2 пункта, 2 пункта (тонкий), 8 пунктов (средний), 16 пунктов и 24 пункта (жирный).

(Различие между первыми тремя толщинами проявляется при высоком разрешении экрана (размере рабочего стола).)

Например, чтобы назначить для прямоугольника абрис шириной 8 пунктов, нужно:

1. Нарисовать прямоугольник.

2. Щелкнуть на инструменте Outline (Абрис) и далее во всплывающей панели выбрать 8 pointline (Абрис 8 пунктов). При выборе ширины линии из всплывающей панели значение ее подтверждается в строке состояния.

Свиток Реn (Перо) унаследован CorelDRAW 8 из более старых версий, однако не потерял своих преимуществ. Открыть свиток можно, нажав кнопку Penrollup (Свиток Перо) во всплывающей панели Outline (Абрис) либо выбрав команду Rollups (Свитки) в меню View (Вид).

Свиток Pen (Перо) позволяет назначать толщину линии, стрелки по концам линий, тип и цвет линии (для выбора цвета открывается окно диалога Color (Цвет абриса)). Преимущество свитка Pen (Перо) (как и других свитков) по сравнению с имеющимся в этой же всплывающей панели инструментом Pendialog (Диалог Перо абриса) в том, что в ходе манипуляций с абрисом свиток не закрывается, а постоянно доступен на экране.

Порядок назначения свойств абриса через свиток Pen (Перо) следующий:

1. Создать новый объект, например произвольную линию.

2. Открыть всплывающую панель Outline (Абрис) и выбрать свиток Pen (Перо).

3. Щелкнуть в свитке кнопку нижнего раскрывающегося списка OutlineColor (Цвет абриса) и выбрать цвет,

4. Открыть раскрывающийся список LineStyle (Тип линии) (второй снизу) и выбрать, например, пунктирную линию.

5. Открыть одно из окон с образцами концов линий и выбрать один из них (для закрытых контуров эти элементы не применяются).

6. Щелкать на стрелке "вверх" в разделе толщины линии, пока толщина не установится на требуемом значении.

7. По завершении определения параметров абриса щелкнуть на кнопке Apply (Применить).

Существенно расширить возможности определения свойств абриса позволяет окно диалога атрибутов абриса. Это окно можно открыть, нажав кнопку Edit (Изменить) в свитке Pen (Перо) или нажав кнопку OutlinePen (Перо абриса) во всплывающей панели инструмента Outline (Абрис).

Окно диалога OutlinePen (Перо абриса) повторяет функции, имеющиеся в свитке Pen (Перо), но в некоторых случаях развивает их, добавляя также новые.

Здесь, в частности, пользователь получает невиданный доселе контроль над типом штриховой или пунктирной линии. Щелчком на кнопке EditStyle (Изменить стиль) открывается окно диалога EditLineStyle (Изменение стиля линии). В этом окне можно получить любой рисунок повторяющихся элементов штриховой или пунктирной линии. Данная возможность появилась только в восьмой версии CorelDRAW.

После определения пользовательского стиля нужно щелкнуть на кнопке Add (Добавить), чтобы добавить этот стиль к списку доступных типов линий.

Разделы Corners (Углы) и LineCaps (Концы линий) управляют видом углов и концов линий, которые можно делать острыми, скругленными или обрубленньми.

Работа с заливками

CorelDRAW 8 позволяет применять к любому выбранному закрытому объекту следующие пять базовых типов заливок:

	Однородная
	Заливка контура одним цветом. Применяемый в CorelDRAW способ описания заполнения, которое состоит только из одного сплошного цвета.

	Градиентная
	Градиентные заливки объединяют два цвета, которые внутри объекта по некоторому закону постепенно переходят друг в друга.

	Заливка узором
	Заполнение, сформированное из растровых или векторных файлов.

	Текстурная
	Заполнение, сформированное из растровых файлов, которые могут быть отредактированы.

	Заливка PostScript
	Заполнение, для генерирования узоров которого используется язык программирования страниц PostScript. Узоры PostScript могут быть видны' только в том случае, если в раскрывающемся списке View (Качество просмотра) в стандартной панели инструментов установлен режим Enhanced (Качественный). Иначе контур будет заполнен буквами PS.


Инструменты для открытия окон диалога заливок разного типа находятся на всплывающей панели Fill (Заливка) (первые пять). Выполнить заливку можно также с помощью свитков Color (Цвет) и Fill (Заливка) на этой же панели (последние две кнопки).

Заливки узором, текстурные заливки и заливки PostScript применяется для создания специальных эффектов. Всего чаще же используются однородные или градиентные заливки.

Заливки можно применять только к закрытым объектам, каковыми являются рассмотренные выше фигуры (прямоугольник, эллипс или многоугольник) или любой произвольный рисунок с замкнутым абрисом.

Для установки цвета однородной заливки CorelDRAW обеспечивает два метода определения цвета:

• использование цветов фиксированной палитры цветов;

• смешивание пользовательских цветов в окне диалога UniformFill (Однородная) или в свитке Color (Цвет). При этом получается цветовая модель, или смешанный цвет.

Если разрабатывается иллюстрация, которая будет фигурировать только на данном мониторе, относительно метода определения цвета можно не беспокоиться. Однако если иллюстрацию надо будет печатать или выводить на Web-странице, при определении цвета необходимо учитывать возможности этих адресатов вывода. Фиксированные палитры часто используются в печати и при выборе цветов для публикации на Web-страницах. Смешанные цвета также используются в цветной печати.

Фиксированные палитры содержат ряд предустановленных цветов. Смешивая эти цвета, можно создавать пользовательский цвет, При воспроизведении файла процессом печати, в котором используется фиксированная палитра, примененная при создании файла, цвета заключительного вывода будут соответствовать проек​тным. Например, если в документации цветного принтера указано, что он может управлять фиксированными цветами из палитры цветов PANTONE, то при разработке иллюстрации для печати на данном принтере придется выбирать цвета из палитры PANTONE. Одну из нескольких фиксированных палитр CorelDRAW можно выбрать в подменю Color Palette (Палитра) меню View (Вид).

Смешанные цветовые модели позволяют определять цвета, объединяя основные цвета или используя системы, которые назначают цветам значения. Наиболее популярна смешанная цветовая модель CMYK, которая позволяет комбинировать цвета Cyan (оттенок синего). Magenta (сиреневый), Yellow (желтый) и Black (черный). Пример использования палитры CMYK — подготовка иллюстрации для четырехцветной печати. При этом можно либо передать на принтер файл CorelDRAW, либо создать пользовательские цветоделения для каждого из четырех цветов.

Системы определения цветов RGB и HSV часто применяются для создания графических образов для Web. RGB означает Red (красный), Green (зеленый) и Blue (синий) и позволяет определять смесь из этих трех цветов.

Модель HSB определяет цвета значениями оттенка (Hue), насыщенности (Saturation) и яркости (Brightness). Оттенок — расположение цвета на цветовом круге или в спектре. Например, оттенки 0 и 359 здесь представляют красный цвет, а 240 — синий. Насыщенность управляет объемом оттенка. Установка насыщенности в 50 добавляет в цвет белые пиксели в соотношении 50/50. Значение насыщенности 0 означает 100% белых пикселей и никаких цветных; при этом создается белый цвет, независимо от того, какое значение введено для оттенка. Установка яркости в 0 создает черный цвет также независимо от оттенка. Наконец, яркость 100 создает для оттенка самый яркий возможный цвет.

Процедуру однородной заливки можно выполнять в окне диалога UniformFill (Однородная) либо в свитке Color (Цвет). Для этого нужно:

1. Выделить объект.

2. Щелчком на инструменте Fill (Заливка) открыть всплывающую панель.

3. Нажать в панели кнопку открытия диалога UniformFill (Однородная) или свитка Color (Цвет).

4. В окне UniformFill (Однородная) нажать слева вверху первую кнопку. Подобрать нужный цвет.

5. Нажать ОК в окне UniformFill (Однородная) или Fill (Заливка) в свитке Color (Цвет).

Для процедуры смешения цветов также может использоваться окно диалога UniformFill (Однородная) или свиток Color (Цвет).

Четыре кнопки в левом верхнем углу окна диалога UniformFill (Однородная) служат для переключения между четырьмя различными способами определена цветов. Первые две кнопки — ColorViewers (Просмотр цветов) и ColorMixer (Смесители) — позволяют смешивать пользовательские цвета. Остальные две кнопки предназначены для выбора цветов из фиксированных палитр. Кнопка More>> (Далее) открывает дополнительные разделы окна диалога, которые дают представление о числовых эквивалентах цветов.

Кнопка ColorMixers (Смесители) открывает страницу, в которой можно смешивать цвета, используя модели CMYK, RGB и HSB. Выбрать метод определение цветов можно в раскрывающемся списке Model (Модель). При выборе пользовательского цвета в окне спектра (слева) в правом разделе окна UniformFir (Однородная) автоматически генерируются числовые значения CMYK, RGB 11 HSB.

Определить градиентную заливку можно в окне диалога FountainFill (Градиентная заливка) (второй инструмент во всплывающей панели Fill (Заливка)) либо а свитке SpecialFill (Заливка) (последняя кнопка во всплывающей панели). Однако самый простой и наиболее интуитивный способ определения градиентных заливок — использовать инструмент InteractiveFill (Интерактивная заливка).

При выборе этого инструмента открывается панель свойств заливки, в которой имеется раскрывающийся список FillType (Тип заливки). Для градиентной заливки нужно выбрать соответствующий элемент списка. При этом в панели свойств появляются два других элемента управления: кнопки FirstFillPicker (Первый указатель заливки) и LastFillPicker (Последний указатель заливки). Эти два раскрывающихся меню определяют начальный и конечный цвета градиентной заливки.

В этой же панели имеются кнопки для выбора стиля градиентной заливки: линейная, радиальная, коническая и квадратная. Эти стили определяют разные законы изменения перехода цветов. После выбора стиля и цветов заливки на выбранном объекте появляются ось с движком, которые можно перемешать и вращать для дополнительного уточнения средней точки, угла и ширины рисунка. (Эти элементы управления дублируются также непосредственно на панели свойств.)

Создать заливки узором и текстурные заливки можно в окнах диалога, которые открываются нажатием соответствующих кнопок во всплывающей панели Fill (Заливка). До опций этих окон можно добраться также, открыв в этой же панели свиток Specialfills (Заливка) (можно также в подменю View (Вид) Roliups (Свитки) выбрать команду Specialfills (Заливка)).

В каждом из этих окон имеются раскрывающиеся меню с целыми галереями узоров, которые можно просмотреть, дополнительно настроить и применить для заливки выбранного объекта.

2.5. Coral Draw. Импорт. Экспорт
Если вы решите открыть в CorelDRAW файл формата JPG или TIFF то ничего у вас не выйдет. Для того чтобы работать с такими файлами, в CorelDRAW существует возможность их импорта. По сравнению с операцией Open (Открыть) при импорте поддерживается значительно большее число форматов файлов. Информация импортируется прямо в область активного документа.
Чтобы импортировать графику нужно вызвать окно Import (Импорт) с помощью команды File > Import (Файл > Импорт). Выпадающее меню, расположенное справа от списка Files of type (Тип файлов), содержит опции для вызова двух дополнительных диалоговых окон Crop Image (Обрезать изображение) и Resample Image (Изменить параметры изображения). Эти окна доступны только при работе с растровыми изображениями.
Для того чтобы импортировать графику:
1. Откройте документ в котором будет размещена импортируемая графика, или создайте новый.
2. Выполните команду меню File > Import (Файл > Импорт). Появится окно Import.
3. В открывшемся окне выберите и откройте папку с импортируемым файлом. Чтобы видеть мини-изображения файлов, установите галочку в поле Preview (Просмотр) и выберите нужный вам формат в списке Files of type (Тип файлов).
4. Возможно далее вам потребуется настроить следующие дополнительные параметры для импорта графики:
- Link bitmap externally - устанавливается связь между импортируемым растровым рисунком и активным документом;
- Combine multi-layer bitmap - при установке данной опции происходит объединение всех слоев в один в импортируемом растровом рисунке;
- Extract embedded ICC profile - включает режим извлечения профиля из импортируемого файла с его включением в общий список профилей, доступных в программе;
- Check for Watermark - задается режим проверки наличия водяных знаков в импортируемом растровом изображении;
- Do not show filter dialog - отменяет вывод на экран диалогового окна с настройками используемого фильтра импорта;
- Maintain layers and pages - включает режим импорта информации, хранящейся в выбранном PDF- или EPS-файле, при котором порядок ее расположения на страницах активного документа останется прежним;
- Link to high resolution file for output using OPI - выбирается режим установления связи, задаваемый OPI (Open Prepress Interface - открытый интерфейс допечатной подготовки), между документом CorelDRAW и растровым файлом высокого качества, который и будет заменен при дальнейшей распечатке.
5. Щелкните по кнопке Import. Если был задан режим обрезки изображения, откроется дополнительное диалоговое окно Crop Image (Обрезать изображение) или Resample Image (Изменить размеры изображения). В открывшемся окне выполните необходимые настройки и подтвердите внесенные изменения нажатием кнопки ОК. Появится изображение уголка с названием импортируемого файла. Установите его в нужном месте рабочего экрана и щелкните мышью, вставив тем самым информацию из данного файла. Если вы будете удерживать кнопку мыши и протащите указатель по диагонали, то вокруг области перемещения указателя появится прямоугольная пунктирная рамка, задающая размер импортируемого изображения, при соблюдении пропорции исходных размеров. Удерживая нажатой клавишу Alt, вы также сможете регулировать размер изображения без соблюдения пропорций по диагонали и горизонтали.
Чтобы добавить в документ отсканированное изображение прямо со сканера или цифрового фотоаппарата, выполните команду File > Acquire Image > Select Source (Файл > Получить изображение V Выбрать источник). В появившемся списке укажите ваше устройство ввода и нажмите кнопку Select (Выбрать). Затем выполните команду File > Acquire Image > Acquire (Файл > Получить изображение > Получить).
Функция экспорта задействуется для переноса рисунков из CorelDraw в другой формат для дальнейшего использования в других графические редакторах или публикациях. 
Чтобы экспортировать графику:
1. Выделите объекты на странице, которые нужно экспортировать и установите галочку в поле Selected only (Только выделенное). Если не установить галочку, то экспортируются все объекты находящиеся в файле (как на странице, так и за ее пределами)
2. Выполните команду File > Export (Файл >- Экспорт). На экране появится диалоговое окно Экспорта.
3. Выберите в списке File of type (Типы файлов), находящемся в нижней части окна, файловый формат, в котором экспортируемая информация должна быть сохранена. При необходимости отсортируйте список файлов, указав нужный вариант в списке Sort type (Тип сортировки).
4. Возможно далее вам потребуется настроить следующие дополнительные параметры для экспорта графики:
- Export this page only - экспорт информации только из текущей страницы документа;
- Selected only - экспортировать только выделенные объекты;
- Web_safe_filenames - режим приведения названий экспортируемых документов в соответствии с требованиями Web-серверов;
- Do not show filter dialog - происходит отмена вывода на экран диалогового окна с параметрами настройки используемого фильтра экспорта.
5. Нажмите кнопку Export (Экспорт).
Если файл экспортируется в растровый формат, появится диалоговое окно Convert to Bitmap (Конвертирование в растровый формат). В этом окне можно изменить размер, разрешение, а также глубину цвета конечного растрового изображения. 
Раздел 3. Анимация Macromedia flash
3.1. Создание изображений с использованием графического редактора Macromedia Flash

Программный пакет Macromedia Flash - это интегрированная среда, предназначенная для создания анимированных изображений различного типа: кнопок, клипов, сложных мультипликационных фильмов и других мультимедийных компонентов web-страниц. Основные компоненты окна Macromedia Flash :

· строка меню;

· палитра инструментов;

· временная линейка;

· список слоев;

· рабочее поле;

· строка состояния.

Панель инструментов  предназначена для создания различных графических изображений. Она состоит из четырех частей. В верхней области Инструменты (Tools) расположены инструменты для рисования и трансформации объектов. Затем идут инструменты для управления отображением Вид (View): Рука (Hand tool), предназначенная для перемещения всей рабочей области и Лупа (Zoom tool), которая применяется для увеличения или уменьшения видимого размера рабочей области (для уменьшения следует щелкнуть в рабочей области при нажатой клавише ALT). Далее расположены инструменты для выбора цвета контуров и заливок - Цвета (Cobrs). Для выбора цвета контуров следует щелкнуть мышью на квадратике со стрелкой вниз рядом со значком карандаша.

Если кнопку мыши не отпустить сразу же, откроется палитра выбора цвета, а указатель мыши примет вид пипетки.

Палитра содержит 216 "безопасных" цветов, которые точно передаются при просмотре на устройствах, использующих 256-цветный режим. Также можно изменить цвет уже существующих контуров - это происходит в том случае, если в момент выбора цвета какой-либо контур изображения выделен. Заливка в программе Macromedia Flash выбирается аналогичным способом и может быть не только одноцветной, но и градиентной. Градиенты могут быть как линейными, так и круговыми. Содержимое раздела Опции (Options) зависит от выбранного инструмента.

Прямоугольник. Можно сгладить его углы, задав радиус скругления.

Карандаш. При выборе инструмента Карандаш в разделе Опции доступны три режима рисования: сглаживание линий, спрямление линий, свободное рисование.

Кисть. Дня Кисти можно задать размер и вил кисти - круглая или квадратная. Кнопка в настройках кисти позволяет выбрать режим рисования:

· рисовать нормально - просто рисование;

· рисовать заливки - закрашивание заливок пустых участков рабочего поля, при этом линии не закрашиваются;

· рисовать позади - закрашивание пустых участков рабочего ноля. При окрашивании кисть как бы покрывает объекты, но если отпустить кнопку мыши, объекты появляются;

· рисовать выделение - закрашивание выделенной заливки;

· рисовать внутри - окрашивает контуры внутри.

Кнопка блокирует цвета и другие параметры заливки относительно поверхности рисования для защиты рисунка от случайных изменений.

3.2. Анимация изображений. Создание сценария для анимации изображений
Одной из интереснейших возможностей Flash является возможность разделения фильма насцены. Каждая такая сцена представляет собой набор дорожек, содержащий логически законченный фрагмент фильма, более или менее независимый от остальных последовательностей. Для работы со сценами служит панель Scene . Чтобы вывести ее на экран, нужно включить пункт-выключатель Sceneподменю Other Panels меню Window или нажать комбинацию клавиш <Shift>+<F2>.

Большую часть этой панели занимает список уже созданных сцен. Мы можем выделить, или сделать текущей, любую сцену, щелкнув на ней мышью. После этого мы сможем произвести над сценой различные предусмотренные Flash манипуляции.

Нужно сказать сразу, что на временной шкале отображаются только те дорожки, что входят в текущую сцену. Просмотреть содержимое остальных сцен, не делая их последовательно, одна за другой, текущими, мы не сможем.

Чтобы создать новую пустую (не содержащую кадров) сцену, следует нажать кнопку Add scene, расположенную в нижней части панели Scene.
Также можно выбрать пункт Scene меню Insert. Новая сцена появится в списке позицией ниже текущей, после чего сама станет текущей. Так что мы можем начать наполнять ее полезным содержимым — кадрами — сразу же после создания.

Каждая сцена фильма должна иметь уникальное имя. По умолчанию Flash дает сценам имена вида Scene <порядковый номер>. Изначально же фильм состоит из одной-единственной сцены, сформированной самим Flash при создании документа и имеющей имя Scene 1.

Вновь созданную сцену желательно сразу же переименовать, дав ей имя, отражающее содержимое (например, Название или Фильм). Для этого достаточно дважды щелкнуть мышью на имени нужной сцены в списке панели Scene. Вместо него появится небольшое поле ввода; введем в него новое имя и нажмем клавишу < Enter> для его сохранения или клавишу <Esc> для отмены.

Есть еще один способ создания новых сцен — дублирование существующих. Для этого служит кнопкаDuplicate scene, расположенная также в нижней части панели Scene.
Выделим в списке панели Scene сцену, которую нужно продублировать, и нажмем эту кнопку. Новая сцена появится позицией ниже и получит имя вида <Изначальная сцена> сору.

Мы можем перемещать сцены в списке мышью, изменяя порядок их воспроизведения. Сцены воспроизводятся последовательно, в порядке сверху вниз.

Для удаления ненужной сцены мы должны будем выделить ее и нажать кнопку Delete scene в нижней части панели Scene.
Flash выдаст предупреждение, говорящее о том, что сцена будет удалена безвозвратно. Нажмем кнопкуОК, чтобы удалить сцену, или Cancel, если мы еще не набрались решимости. Чтобы сразу же удалить ненужную сцену без вывода этого предупреждения, можно щелкнуть по кнопке Delete scene,удерживая нажатой клавишу <Ctrl>.

Теперь вернемся в окно документа. В правой части инструментария документа находится кнопка Edit Scene, при нажатии которой на экране появляется меню созданных в документе сцен. Чтобы сделать какую-либо сцену текущей, достаточно просто выбрать соответствующий пункт-переключатель этого меню.

Кстати, эти же пункты-переключатели присутствуют в нижней части подменю Go to меню View.

В том же подменю Go to меню View находятся пункты, которыми мы можем пользоваться для "путешествия" по сценам. Этих пунктов четыре:

First — переход к самой первой сцене в списке панели Scene;

Previous — переход к предыдущей сцене;

Next — переход к следующей сцене;

Last — переход к последней сцене.

При воспроизведении готового фильма в среде Flash (его, как мы помним, запускает пункт Play менюControl и клавиша <Enter>) нужно иметь в виду, что по умолчанию воспроизводится только содержимое текущей сцены. Чтобы просмотреть весь фильм (в смысле, все его сцены), нужно будет сначала включить пункт-выключатель Play All Scenes меню Control.

Напротив, при воспроизведении фильма в отдельном окне (пункт Test Movie меню Control или комбинация клавиш <Ctrl>+< Enter>) фильм всегда воспроизводится полностью, со всеми сценами. (Кстати, точно так же ведет себя и проигрыватель Flash.) Если же мы пожелаем просмотреть в отдельном окне только текущую сцену, выберем пункт Test Scene меню Control или нажмем комбинацию клавиш <Ctrl>+<Alt>+<Enter>.

И еще кое-что о сценах, точнее — о необходимости их использования.

Сцены Flash — инструмент, предназначенный, в основном, только для разработчика фильмов. Сцены позволяют разделить длинный фильм на несколько частей и работать потом с этими частями по отдельности. Проигрыватель Flash, судя по всему, никак сцены не обрабатывает; более того, похоже, он вообще не знает об их существовании. Так, если мы загрузим в него файл Shockwave/Flash с фильмом, содержащим сцены, они будут воспроизведены последовательно, одна за другой.

Осталось сказать совсем немногое. А именно: нумерация кадров фильма при использовании сцен остается сквозной, проходящей через все сцены. 

3.3. Создание клипа, содержащего анимацию

Flash предоставляет возможность создавать экземпляры-клипы на основе имеющихся в библиотеке образцов, дублировать уже созданные на рабочем листе клипы и даже создавать абсолютно новые клипы, не основанные на имеющихся в библиотеке образцах. Давайте выясним, как все это реализовано.

Проще всего, конечно, создать новый клип, продублировав уже имеющийся на рабочем листе, вместе с его графикой, анимацией и сценариями. Для этого используется действие duplicateMovieClip. Формат его вызова таков:

duplicateMovieClip(<Дублируемый клип>, "<Имя создаваемого клипа>", <Порядок перекрытия нового клипа>);

С первым параметром передается путь исходного клипа, который нужно продублировать. Со вторым параметром передается имя вновь создаваемого клипа; оно должно иметь строковый тип и быть уникальным. Последний, третий, параметр определяет порядок перекрытия нового клипа; он должен иметь числовой тип.

Однако при создании нового клипа способом дублирования нужно учесть четыре момента. Во-первых, содержимое переменных, объявленных в сценариях дублируемого клипа, а также его свойств не копируется в новый клип. Во-вторых, если дублируемый клип содержит анимацию, то в новом клипе она в любом случае начнет воспроизводиться с самого начала. В-третьих, созданный таким образом клип вкладывается в тот клип, в котором находится продублированный клип. В четвертых, созданные с помощью действия duplicateMovieClip клипы в порядке перекрытия всегда находятся "выше" созданных вручную.

Чтобы создать совершенно новый клип, основанный на библиотечном образце-клипе, используется метод attachMovie объекта movieClip. Формат его вызова следующий:

<Клип>.attachMovie("<Имя сценарного образца>",

"<Имя создаваемого клипа>", <Порядок перекрытия нового клипа>);

Метод attachMovie вызывается для клипа, в который должен быть вложен вновь создаваемый клип. Второй и третий параметры нам уже знакомы, так что не будем останавливаться на них. А вот о первом параметре нужно поговорить подробнее.

Дело в том, что для успешного использования в методе attachMovie образец-клип нужно превратить в так называемый сценарный — доступный для вызова из сценария. Сейчас мы выясним, как это делается.

Первым делом нужно вывести на экран панель Library. Далее найдем в списке этой панели нужный образец и выберем в контекстном или дополнительном меню пункт Linkage, после чего на экране появится давно знакомое нам диалоговое окно Linkage Properties .

Чтобы превратить образец в сценарный, нужно включить флажок Export for ActionScript и ввести идентификатор создаваемого образца в поле ввода Identifier. Все почти так же, как и в случае разделяемых образцов.

Далее нам нужно решить, куда будут помещены массивы данных этого сценарного образца. По умолчанию все они помещаются в первый кадр фильма и, соответственно, загружаются перед тем, как фильм начнет воспроизводиться. Если таких образцов слишком много или если они очень велики, пауза перед выводом первого кадра фильма может затянуться. Но мы можем заставить Flash поместить массив данных образца в тот кадр фильма, в котором они впервые встречаются. Для этого достаточно отключить флажок Export in first frame.

Однако здесь нас подстерегает другой сюрприз. Если мы не использовали где-либо в фильме сценарный образец, то Flash не поместит его в результирующий файл Shockwave/Flash, справедливо полагая, что он здесь лишний. Что мы там написали в сценариях, его (Flash) не касается. Так вот, для того чтобы Flash все же сохранил сценарный образец в готовом фильме, нам придется все-таки поместить его экземпляр на рабочий лист, задав для него либо очень маленькие размеры, либо максимальную прозрачность.

Вот, собственно, и все. Осталось нажать кнопку ОК окна Linkage Properties. И можно использовать готовый сценарный образец.

Приведенный ниже сценарий добавит в наш автомобиль лишнюю фару, создав ее на основе сценарного образца headlight:

_root.car.attachMovie("headlight", "headlight3", 0);

Flash также позволяет поместить на рабочий лист "пустой" клип. Это выполняется с помощью метода createEmptyMovieClip объекта movieClip. Формат вызова метода такой:

<Клип>.createEmptyMovieClip("<Имя создаваемого клипа>",

<Порядок перекрытия создаваемого клипа>);

Метод createEmptyMovieClip вызывается для того клипа, в который нужно вложить создаваемый "пустой" клип. Оба его параметра нам уже знакомы.

Запишем сценарий с использованием этого метода:

_root.createEmptyMovieClip("tractor", 0);

Этот сценарий поместит на рабочий лист новый "пустой" клип tractor — в компанию к нашему многострадальному автомобилю. Конечно, никакого трактора там пока что нет, но — лиха беда начало…

Когда-нибудь нужда в созданных с помощью всех этих действий и методов клипах отпадет, и их придется удалить. Для удаления же клипов предназначено единственное действие removeMovieClip, записываемое в следующем формате:

removeMovieClip(<Удаляемый клип>);

Например, для того чтобы удалить пятое колесо, подойдет такой сценарий:

removeMovieClip(_root.car.wheels);

Обойдемся без запаски — авось гаишник не остановит.

Для удаления клипа можно также воспользоваться методом removeMovieClip объекта movieClip. Формат его вызова очень прост:

<Удаляемый клип>.removeMovieClip();

С помощью действия или метода removeMovieClip можно удалить только те клипы, которые созданы из сценариев. Клипы, созданные в среде Flash, не могут быть удалены таким образом.

Не стоит думать, что Flash может только создавать, дублировать и удалять вложенные клипы. Сейчас мы рассмотрим свойства и методы объекта movieclip, с помощью которых можно изменять различные параметры встроенных клипов: местоположение, размеры и пр.

Так, свойства _х и _у объекта movieclip предоставляют доступ соответственно к горизонтальной и вертикальной координатам клипа. Эти координаты отсчитываются в пикселах от точки отсчета клипа и задаются относительно внешнего клипа, т. е. того, в который текущий клип вложен.

Свойства _xscale и _yscale задают процент изменения размеров клипа соответственно по горизонтали и вертикали. Значения, большие 100, заставляют клип увеличить соответствующий размер, а меньшие 100 — уменьшить. Так, если задать для свойства _xscale значение 50, то клип сожмется по горизонтали вдвое.

Свойство _aipha позволяет получить или задать степень прозрачности клипа. Доступны любые целые значения от 0 (полная прозрачность) до 100 (полная непрозрачность).

Свойство _rotation задает угол поворота клипа в градусах. Например:

onClipEvent(enterFrame) {

++this._rotation;

— this._alpha;

}

Этот сценарий заставляет вложенный клип в процессе воспроизведения фильма плавно поворачиваться и одновременно плавно исчезать. Фактически мы можем создавать настоящую анимацию только средствами ActionScript.

Свойство _visible позволяет сделать клип невидимым. Оно имеет логический тип: значение true делает клип видимым, а значение false — невидимым.

onClipEvent(mouseDown) {

this._visible = ~this._visible;

}

Этот сценарий при каждом щелчке по клипу делает его то видимым, то невидимым.

А теперь познакомимся с методами объекта MovieClip, с помощью которых можно изменять порядок перекрытия встроенных клипов.

Метод getDepth возвращает порядок перекрытия текущего клипа. Этот метод не принимает параметров.

Метод getNextHighestDepth возвращает ближайшее верхнее значение уровня перекрытия, еще ничем не занятое. Его можно использовать при создании новых клипов. Например, так:

var clip2 = clipl.duplicateMovieClip("clip2",

_root.getNextHighestDepth());

Это выражение создаст новый клип clip2, продублировав уже имеющийся на рабочем листе клип clip1, и поместит его "над" всеми клипами.

Метод getinstanceAtDepth возвращает ссылку на клип, имеющий заданный порядок перекрытия. Значение порядка перекрытия передается в качестве единственного параметра.

Метод swapDepths меняет значения порядка перекрытия двух клипов местами. Формат его вызова таков:

<Клип 1>.swapDepths("<Клип 2>"|<Порядок перекрытия>);

В качестве параметра этого метода может быть передан путь второго клипа или значение нужного порядка перекрытия. Причем путь второго клипа передается как строка.

Вот три примера использования этого метода:

_root.car.swapDepths("_root.tractor");

_root.car.swapDepths (10);

_root.car.swapDepths(_root.tractor.getDepth());

Получение служебной информации о клипе

Объект MovieClip поддерживает набор особых свойств, доступных только для чтения. Эти свойства возвращают различную служебную информацию, зачастую не относящуюся к самому клипу. Ниже перечислены некоторые из них.

Свойство _name возвращает имя клипа, заданное с помощью панели Properties, в строковом виде.

Свойство _target возвращает полный путь клипа в строковом виде.

Свойства _xmouse и _ymouse возвращают соответственно горизонтальную и вертикальную координаты курсора мыши относительно точки отсчета клипа. Пользуясь этими свойствами, можно контролировать перемещения мыши. Например:

onClipEvent(enterFrame) {

myCursor._x = _root._xmouse;

myCursor._y = _root._ymouse;

}

Этот сценарий заставляет вложенный клип myCursor перемещаться вслед за курсором мыши. Фактически сам клип будет вести себя как курсор мыши.

Раздел 4. Индивидуальное задание

4.1. Разработка визитки
Разработала в CorelDRAW визитку для школы:
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